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FOREWORD
I have spent more than half my life in a relationship with Photoshop. It’s a 
pretty healthy one, and we discover new things about each other even now. 
Like other couples we argue from time-to-time… you know how it is. But at 
the end of the day, we end up bringing out the best in each other.

It all started while I was studying for a degree in Imaging and Photographic 
Technology at Rochester Institute of Technology (RIT). My track had plenty 
of MATLAB, optics, and digital image processing, but I wanted to play in the 
pixels like they were finger paint. So I managed to get into the not-in-my-major 
class to use this awesome software called Photoshop—never imagining I’d 
spend my career at Adobe with the honor of representing Photoshop users.

I’d always considered myself creative, an artist. When I was 10 my dad got a 
free 35mm camera with his subscription to a magazine. I later used that same 
camera (covered in electrical tape to stop light leaks) in my high school pho-
tography class. That class was where I first began experimenting with imag-
ing. I only had a standard lens, so I improvised macro shots with a magnifying 
glass in front of my 50mm. A classmate discovered reticulation by accident, 
but I liked the shattered look of the warped emulsion and replicated the pro-
cess. I did a lot of creative experimentation before moving to the scientific side 
of imaging. Photoshop was the perfect medium for me to bring the two sides of 
my imaging experience together.

Scott Valentine also has a relationship with—and helps bring out the best in—
Photoshop. He’s been a key beta tester of the application and an advisor to the 
engineering team for more than a decade. Actually, as long as I can remember, 
Scott has been our partner.

One aspect that makes Scott unique and valuable to the team is that he is both 
artistic and intellectual. He makes his own beautiful creations to walk through 
the new Photoshop code and even creates test images to exercise and dissect 
features. The team has come to count on Scott’s dexterity of science and art to 
help discuss and debate the direction of the application.



xii THE HIDDEN POWER OF ADOBE PHOTOSHOP

I’m pleased to see that this book, The Hidden Power of Photoshop for Photog-
raphers, stays true to Scott’s balance of art and intellect to take readers on a 
journey of experimentation, discovery, and mastery. The symmetry of the 
conversational, approachable style of Scott’s writing with his deeply inquisitive 
nature make this must-read material. I expect by the end, readers will be able 
to power their own tools the way the Photoshop team does.

—Meredith Stotzner,  
Photoshop Product Manager, Adobe
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pleasant, supportive relationship. We loved, we fought, we talked about trial 
separation and who would get the dogs… but in the end, we stuck together.

My wife and son were infinitely patient, the dogs less so. My first round of 
acknowledgement and thanks go to my family for knowing when not to ask 
“how’s the book coming?” They showed amazing restraint and kept providing 
encouragement.
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they probably should have walked away. This pair of amazing professionals 
shifted between roles of friend and business partner seamlessly and smoothly, 
and I’ve learned a lot from them. These few words are not thanks enough for 
their efforts which started quite literally from the inception of this book and 
continued through it resting in your hands.

Longtime friend and Photoshop mentor Rocky gave his expertise for a fourth 
time, catching my errors and teaching me some new tricks along the way. Any 
technical faults in these pages exist because Rocky let me win an argument. 
He’s the best that way!
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DODGE & BURN

Dodging and burning are cornerstone darkroom techniques, 
and there’s no getting away from their benefits in the digital 
world. Fortunately, there is no end to the possible variations 
here.

When dealing with pixels, Photoshop allows many different 
ways to accomplish the crucial tasks of dodging and burn-
ing, the classic darkroom techniques of selectively lightening 
(dodging) or darkening (burning) individual areas of an image 
to regulate exposure. The specific method you choose should 
reflect both how you work and what level of control you desire. 
And, you should freely move between techniques as the work 
demands.
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DODGE & BURN METHODS
The most basic approach to dodging and burning (or “D&B”) in 
Photoshop is to use the dedicated Dodge and Burn tools, selected 
with the O shortcut key. If you use these tools directly on your 
photograph layer, however, they are destructive because they 
permanently change the pixels in your image. This might be best 
suited for making small refinements during a compositing proj-
ect, for example.

The Dodge and Burn tools can also cause color shifting, as they 
are effectively operating with the Color Burn and Color Dodge 
blending modes. With the  Protect Tones option enabled, the 
effect can be reduced, but this ultimately results in some desatu-

ration. In this example portrait, the area under the  model’s eye has a “cor-
rected” exposure value, but the color is almost completely missing from the 
highlight area.

Fortunately, both tools let you choose a tonal range (Highlights, Midtones, 
Shadows) as well as a relative power setting called Exposure. The controls for 
these appear in the context-sensitive options bar when one of the tools is cur-
rently active. Choose the appropriate range, and drop the Exposure setting to 
around 20% so you can sneak up on the corrections.

Working carefully over your image, you can exercise reasonable control but be 
warned: Except for using the Undo command, you can’t completely recover the 
altered pixels back to their original state. Going too far with either of the tools 
typically causes unwanted artifacts, as well.

One way around these problems is to make your adjustments on a duplicate 
of your photograph layer. That way if something goes wrong, you can simply 
lower the opacity of the layer, use a layer mask, or replace the problem area 
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with a new selection from the original. The down side is that this approach 
adds to file size.

Other methods allow for a lot more flexibility and don’t really have an impact 
on file size or performance, so the only compelling reason to continue to use 
destructive tools directly on your image layer is for speed in making minor 
corrections to small areas. Personally, I use these dedicated tools almost exclu-
sively for working on masks, which is covered in the section, “Tweaking Chan-
nels & Masks.”

OVERLAY
Let’s start with a popular and time-tested method that uses a blank layer to 
hold your image corrections separate from the photo layer.

Start by filling a blank layer with 50% gray and setting its blend mode to 
Overlay. The Overlay blending mode ignores 50% gray but selectively dark-
ens or lightens based on the gray value of the blend layer. That means the 
50% gray overlay layer is effectively invisible until you begin working on it. 
Using the Dodge and Burn tools on this intermediate layer is probably your 
best approach, if you feel most comfortable with these tools.

The only purpose of using a filled layer is to be able to use the actual Dodge 
and Burn tools. Another option that gives you more expressive control is to 
skip the fill step and paint directly on a blank layer set to Overlay blending. 
Use a standard brush set to low flow and low opacity values, and paint with 
shades of gray (50% gray will of course have no effect). This lets you build up 
the effect slowly, with more control to avoid harsh transitions in value. You can 
set foreground and background colors to the default black and white by press-
ing the D key, and then toggle between them with the X key. 

As a bonus, paint with colors sampled from your image to adjust saturation 
at the same time. The Overlay blending mode is effectively the same as using 

TIP To fill a layer and set 
its blending mode all in one 
action, press Shift+F5. This 
calls up the Fill dialog box 
with choices for types of 
fill (black, white, 50% gray, 
foreground, background, 
patterns, etc.), which blend-
ing mode to apply to the 
layer, and the layer opacity. 
Remember to use this on a 
blank layer or with an active 
selection.
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Multiply for darker areas, and Screen for lighter (see the “Blending Modes” 
chapter of Part IV, “References” for more details). Using this painting technique, 
it’s possible to retain some of the richness that might be lost when painting 
with only black or white.

In this rogue’s portrait, it was important to retain the slightly oversaturated 
look so painting with color as described helps increase the density of the 
darker tones while preserving and slightly increasing the saturation in the 
lighter tones.
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You still have to be careful when painting on this layer because extreme 
changes can have bizarre results and also create artifacts. While you can 
always go back and repaint certain areas, you might also end up introducing 
small artifacts without realizing it.

Just for fun, here’s an example of how you can use the color-based technique 
for more than just styling. I treated these toy guns to a little color adjustment 
and then gave them a flat, masked texture layer. On top of that I added the 
Overlay D&B layer and manually painted with color, black, and white to  create 
details and effects. 

USING CURVES
My preferred starting technique for dodge and burn is to use a pair of Curves 
adjustment layers that are set up to limit the dodge and burn effect. This helps 
prevent some of the artifacting and extreme changes that are possible with the 
Overlay layer painting method. You also get the added benefit of separating 
the darkening and lightening effects to distinct layers.

To start with, create one Curves adjustment layer above your scene, and drag 
the center of the curve upwards to the point where the darkest parts of your 
image are as light as you think you’d ever want them to be. Name this layer 
Dodge. Fill the mask with black.
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Create another Curves adjustment layer above that, and drag its curve down 
so that the brightest areas are as dark as you want them to be. Name this one 
Burn, and also fill its mask with black.

For organization, group them together and name the group Dodge & Burn or 
whatever makes sense for your work.

TIP Once you have used the 
Fill dialog box, the settings 
for blending mode, fill type, 
and opacity will be persistent 
while Photoshop is open. 
Pressing Shift+F5 or using 
Edit > Fill will show you the 
last settings you used.
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From here, you will use the Brush tool to paint with white on the mask of each 
layer. Use a soft brush with low settings for Flow and Opacity just as with the 
previous method. This means you will be working on only one adjustment at 
a time.

There are several advantages to this particular approach. First, it gives you 
discrete control over the dodge and burn operations independently. If you need 
to adjust the opacity of either of the layers, you can do so without affecting all 
of your adjustments at once. Additionally, working with just one type of cor-
rection at a time helps you focus a little better on the global adjustments.

D&B BEST PRACTICES
As a general workflow recommendation, I suggest starting with large adjust-
ments first, such as overall shaping and setting visual focus, such as lightening 
the face in a portrait, the foreground in a landscape, or creating soft vignette 
effects to guide the viewer’s eye around the image. The next pass would be 
intermediate features, and then finally a detail pass.

This example shows the mask from the first (the “Big” pass) Burn layer.

I also recommend using multiple D&B groups to keep them flexible and dis-
tinct. Using one pair of Curves each for large, medium, and small features gives 
you a lot of flexibility in balancing them later on. Each pair, and indeed each 
individual adjustment layer, can be modified without affecting the others. Of 
course, you can adjust the curves on each as well.
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This same principle goes for working with the Overlay painting method: Use 
several layers rather than putting everything on one. For a more detailed work-
flow, look in Part III, “Project Examples.” The Rembrandt Portrait shows off a 
couple of different dodge and burn techniques grouped together.
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INSTANT IMAGE ENHANCEMENT
With all of the blending modes available in Photoshop, and 
the stunning array of techniques in which you can use them, 
it’s sometimes easy to forget that they can be used directly for 
some basic image enhancement. The four most popular blending 
modes for this are:

	● Multiply

	● Overlay

	● Screen

	● Soft Light

Most of the time, you will hear advice on duplicating a photo 
layer and setting the duplicate to one of those four modes. Multi-
ply darkens, Screen lightens, and Overlay and Soft Light increase 
contrast. Using this little trick is a great way to jump start lots of 
images, but let’s explore some variations on this theme.

First, rather than duplicating the photo layer, you can generally use any adjust-
ment layer instead. Without making any other changes, the adjustment layer 
behaves like a copy of the image, especially when it’s clipped to the photo. 
This immediately gives you additional flexibility; not only do you get the exact 
same effect, including the ability to change opacity and advanced blending, 
you also get the features of the adjustment layer itself.



94 PART II: TECHNIQUES

Adding a Curves adjustment set to Overlay gives a nice contrast, but you can 
take advantage of so much more. For example, I started by raising the left side 
of the curve to lighten up the muddy shadow regions and make everything a 
little less heavy.

Stepping through the channel curves lets me run some color work to shift the 
overall tone towards reds and purples. Each channel can be adjusted individu-
ally, so this is a good way to explore a lot of variations.

Finally, a little tweak in the Advanced Blending section of the Layer Style 
dialog box, using the Blend If section’s Underlying Layer sliders, allowed me to 
smooth out the shadows a bit more. I finished by lowering the Opacity setting 
(in this case, to about 90%).
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This represents a lot of the early heavy lifting that can be done with a single 
adjustment layer, all non-destructively.

You can use this general approach for correction or enhancement, or just to try 
out lots of different versions. This time, let’s use Screen, which initially blows 
out the highlights quite a bit. Again, the composite curve gets some dramatic 
tugging to bring back the highlights, and then each individual channel is 
adjusted to end up with a gold tone (increase Red and Green, decrease Blue). 

Each of the adjustment layers can behave this way, with the exception of 
Threshold, Inverse, and Posterize. These three will immediately apply their 
own effect. You can use Photo Filter if its Density slider is moved to zero, and 
the Color Lookup Table will be neutral until a lookup table is applied (once you 
choose one, however, there is no way to remove it completely without simply 
deleting the adjustment layer).

Choosing which adjustment layer to use for blending mode effects comes 
down to the usual question: What do you want to accomplish? For most 
purposes, I stick with a Curves layer simply because of its flexibility and 
power. Blending with other adjustments affects how they behave, so let’s 
take a look at why you might consider certain blending modes for different 
adjustment layers.

Because, as you saw, the four most popular blending modes all have an imme-
diate and independent effect, it makes sense to pair them with adjustments 
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that complement them in some way—either enhancing or mitigating their 
results. The Curves and Screen result is a good example of reducing the effect, 
or “pulling it back.” Similarly, using Soft Light with a Color Lookup Table (using 
the Foggy Night preset) gives a gritty look.

In one final example, this single frame is reasonably well exposed but kind 
of boring. To enhance the contrast, I added a Curves adjustment layer set to 
Overlay blending mode, which had nice results in the midtones, but muddied 
the shadows and blew out the highlights.

To correct for this, I went to the Advanced Blending section in the Layer Style 
dialog box set Blend If to Gray, and split the Underlying Layer sliders.
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Splitting the sliders in this way allows the enhanced contrast to reach to the 
shadows and highlights more gradually, avoiding serious loss of detail.

HARD MIX CONTRAST
A more specialized application of using an adjustment layer to 
apply a blending mode takes advantage of the special nature of 
Hard Mix; it behaves differently when used with Fill compared 
to Opacity. See the “Blending Modes” chapter in Part IV, “Refer-
ences” for more details on why this is.

For images with low contrast, especially due to haze or extremely 
soft light, this trick can do some pretty amazing things. The shot 
below is from Coronado, California, showing some early morning 
fog. There’s not much detail or contrast to work with.
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Just adding a Curves adjustment set to Hard Mix, and lowering the Fill to about 
60% gives a pretty dramatic change everywhere so there’s at least some detail 
to work with.

If you’ve used the Clarity slider in Camera Raw or Lightroom, this effect will 
look familiar to you. By now, you should recognize a good opportunity to use 
Blend If to clean up the muddied shadows. Splitting the sliders and in this case, 
crossing the highlight and shadow regions recovers those muted blacks well.

At this point, we can start to apply some of the usual techniques to adjust color 
and contrast in any way we like. Because we already have a Curves adjustment 
for free, let’s exploit that by tweaking the individual channel curves a bit. I 
want a warmer, dreamy effect in this version. That requires a tiny boost in red 
and green, with blues dropping out. From the menu in the Curves Properties 

NOTE Pay attention to the 
fact that the Blend If slid-
ers can be crossed at any 
time, including when split as 
shown in the screenshot. It is 
worth a few moments of your 
time to explore this capabil-
ity by setting the Fill value 
back to 100% and completely 
swapping the Black and 
White stops, splitting them 
arbitrarily and using extreme 
values. This gives you a sense 
of how flexible this ability 
really is.
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panel, choose each of the channels in turn and apply minor changes. The thing 
to keep in mind, if you’re not familiar working on each color channel individu-
ally, is that you’re looking mostly for tonality in the first color you adjust, then 
sneak up on the colors you want with the remaining channels (more on this in 
a bit). The figures show what I ended up using.

The adjustments to each channel are pretty small, except the Blue channel 
where I wanted to retain some coolness in the deep shadow areas. I really enjoy 
this technique because it can recover some otherwise unusable images. And in 
this case, it only took one layer to do pretty much everything I wanted.
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A more complicated picture is this lonely cactus in the northern New Mexico 
snow. It already has some bright areas and lots of tiny details with the snow-
flakes blowing about.

The photo was intentionally underexposed to preserve some texture in the 
snow patches, which means additional steps will be needed to avoid blowing 
out highlights. Also, the darks are perilously close to full black. That suggests 
we should attack the mids and low mids more than anything, and so this is 
a great spot to try out a few tricks. In the “Selections & Masking” chapter, I 
showed you a quick way to select ranges of values in an image using a Gradi-
ent Map.
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With the Gradient Map visible, it’s fairly easy to pick out the range we want to 
affect. In this case, it’s the slightly brighter midtones. Close the Gradient Editor 
and in the Channels panel, make a selection from any of the channels, then 
turn off the Gradient Map adjustment layer. Create a Curves adjustment layer; 
the mask is automatically applied. Here’s the result of setting the unchanged 
curves layer to Hard Mix at 40% Fill.

The brightest highlights in the snow and darkest shadows around the rocks are 
untouched, but the high mids are moderated. Let’s talk a moment about why 
this is an advanced move. While I did not have a final vision in mind, I could 
describe some of the features I wanted in the results: Protect the ends of the 
dynamic range, and increase contrast and detail in the upper mids. Setting just 
those goals allowed me to use previously known skills to make an intelligent 
choice in creating the mask, namely by isolating the region of interest.

Further, we know that the Masks Properties panel comes with some extra 
goodies, such as Density and Feather adjustments, as well as the ability to 
access the Select And Mask workspace for refinement. Rather than hand paint-
ing the mask or trying to carefully combine multiple selections, the first pass 
got me close to an 80% solution, or more. The Feather and Density controls 
also allow me to exercise non-destructive creative decisions about the mask. I 
can even use Blend If should I wish.
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The default transition between masked and not masked is a little harsh, and 
I would like just a touch more contrast in the areas I previously excluded. For 
this image (about 7400 px by 5000 px), a feathering setting of 36 px nicely 
blends those regions. I also dropped the Density setting to about 80%.

To finish this piece off, I added a Hue/Saturation adjustment to drop the 
saturation a bit, then added a Color Lookup adjustment using the Candlelight 
preset and lowered its Opacity setting to 45%.
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GRADUATED NEUTRAL 
DENSITY FILTER
Graduated Neutral Density (GND) filters are popular pho-
tographic tools that enable you to balance scenes with wide 
dynamic range. These glass filters attach to the front of a camera 
lens, and photographers typically use them for landscapes, sun-
sets, sunrises, and other scenes where the sky is far brighter than 
the land. A basic ND filter behaves effectively like sunglasses 
for your camera, reducing all incoming light (hopefully in equal 
amounts across the spectrum). A Graduated ND filter has a den-
sity ramp (a gradient) from clear to dark, allowing you to more 
easily balance exposure in a single frame by aligning the clear-to-

dark transition with the appropriate areas of your scene. You can create GND 
filters in Photoshop to help balance your images in the same way. In addition, 
you can use them to create vignettes and other artistic looks. Just don’t expect 
miracles: The following GND methods can’t recover detail that is already lost 
in your original image, either by shadows that are too dark or highlights that 
are blown out.

The traditional digital approach for a sunset photo is pretty simple, assuming 
the sky is a bit too bright for the foreground. Create a blank layer, name it GND, 
press D to set the default foreground and background colors to black and white, 
and then grab the Gradient Tool (G). From the options bar, choose a linear gra-
dient, and then drag from top to bottom while holding the Shift key. The Shift 
modifier ensures the gradient is dragged perfectly in the vertical (or horizontal 
or at 45 degrees, depending the direction you drag). Your result should be black 
at the top and white at the bottom.

Change the blending mode of the GND layer to Multiply to start. Notice the 
black areas bring down highlights, while the white areas of the gradient don’t 
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have any effect on the image. Lower the Opacity of the GND layer until the 
values are more balanced. Unfortunately, I find that many images suffer from 
loss of saturation, and the result is something a little too muted for my taste.

Instead, I like to experiment with Color Burn and Overlay, depending on the 
dynamics and what I want out of the process. Color Burn can be really, really 
harsh, but fortunately it responds differently to Fill than it does to Opacity. For 
this particular image, lowering the Fill setting of the GND layer to about 55% 
gives a great result for the sky in this example.

In some situations, it may be better to actually duplicate the photo layer 
rather than applying a gradient. Duplicate the photo, and change the copy’s 
blending mode to Multiply. Use the Gradient tool to add a layer mask to the 
copy, and this time let the sky show through while masking the foreground. 
Keep in mind that while a mask is selected, pressing D will load white to the 
foreground and black to the background, but also swaps the gradient colors if 
you’re using Foreground To Background as a preset.
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Both methods allow for all kinds of customization and tinkering. Duplicat-
ing the photo layer and using Multiply quickly burns the image overall, so 
be sure to keep an eye on artifacts in the darker areas. But any color regions 
will immediately start to pop. Similarly, Overlay will burn dark areas while 
dodging light areas—something to keep in mind if you are dealing with a low-
contrast image, such as on a hazy, gray afternoon.

The next step in building on GNDs is to expand the idea to vignettes. While 
the technique is very similar, the intent is quite different. A GND is meant to 
manage dynamic range; vignettes are primarily meant to guide the viewer’s 
eye around the photograph.

CREATIVE VIGNETTES
Vignettes use the same basic principles as the graduated neutral 
density techniques, but applying them is much more of a creative 
endeavor than a corrective one. As such, the possible variations 
open up quite dramatically. Honestly, anything you do to change 
the value around the perimeter of your image with the intent of 
drawing focus to your subject counts as a vignette. Of course, 
some methods are more popular than others.
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To illustrate the concept, let’s grab the Gradient tool and choose a Foreground 
To Transparent gradient with the Radial style. You may have to switch your 
foreground color to black, and in the options bar select the Transparency 
option. Also ensure Reverse is checked in the options. On a blank layer above 
your image, drag from center of the canvas to any edge. Name this layer 
Vignette for now.

Without blending modes applied to the Vignette layer, the result is predictably 
dark, but satisfies the basic description of a vignette. In fact, a solid, unblended 
look is more traditional to vintage film photography. On the Vignette layer, 
press Command+I (macOS)/Ctrl+I (Windows) to invert the black to white.
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There is nothing that requires a vignette to be anything other than something 
to obscure the border of an image, and even that is not truly necessary. To that 
end, you can employ shape, color, and size in any way you as the artist see fit. 
Using the white vignette as on the previous page evokes old-style prints and 
can be useful in selling an idea of history in your work, especially with ton-
ing techniques like Sepia or Selenium (examples of which can be found in the 
“Color & Value” chapter).
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Moving on to a more robust workflow, let’s add a Gradient Fill adjustment layer 
at the top of the layer stack (you’ll delete the Vignette layer later). When you 
first add a Gradient Fill adjustment layer to your document, the Gradient Fill 
dialog box pops up with a few controls. Choose Radial from the Style menu, 
then select the Reverse option (it may still be selected if you followed the pre-
vious technique). Finally, open the Gradient Editor by clicking the gradient 
swatch itself. Move the dialog box around so you can see the results of your 
changes immediately on the canvas.

For this example, I’m using the Cyanotype preset from the Photographic 
 Toning collection (see Note). Because the gradient layer needs to have a trans-
parent region but the preset is 100% opaque, we can either use a mask on the 
Gradient Fill layer or build some transparency into the gradient itself. To be 
more flexible, let’s create a new preset with its own transparency. The stops 
at the top of the gradient preview bar are for opacity. In this case, we want to 

NOTE If you have not used 
gradient presets before and 
are using Photoshop 2020, 
then you’ll need to load the 
Photographic presets for 
some of the described looks. 
Choose  Window > Gradients 
and open the panel options 
menu. Choose Legacy Gradi-
ents to load the presets you 
see in the text.

NOTE Why select Reverse? 
Because the color ramp in 
the Gradient Editor presumes 
the left edge is the center of a 
radial gradient, and we need 
the transparent region on the 
right to be in the center of the 
document instead. Most of 
the presets will place darker 
areas on the left and lighter 
on the right of the gradient 
ramp. Using the Reverse 
option keeps us from having 
to rebuild the gradients.
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make the white region transparent; click on the Opacity stop above the right 
edge of the bar, then change the Opacity setting at the bottom of the window 
to 0%.

I find in many cases that I prefer to move each of the color stops to the left to 
control the size of the gradient. That way the colors from the original gradi-
ent are still included. Before I close the Gradient Editor, I want to save the new 
gradient as a preset. Choosing New lets me save the preset, and I can drag it to 
any collection in the editor window.

Closing the Gradient Editor window takes us back to the Gradient Fill box, 
where we can do some additional refinement by adjusting the Scale so that the 
effect is pushed out more towards the edges. There is one more thing we want 
to do before closing this dialog box.

With the Gradient Fill box open, deselect “Align 
With Layer” so you can drag the gradient around 
on the screen. That way you aren’t locked in to hav-
ing the center of the vignette right in the middle of 
your image. Also try out the Angle settings to see 
the effect on the shape of the vignette; for radial 
gradients, this changes the shape from circular to 
oval. Drag the gradient where you like, and click 
OK to close the dialog box. If you need to reposition 
it, you’ll have to open the Gradient Fill box again by 
double-clicking the adjustment layer icon.



111DoDge & Burn

With the gradient in place, you can change the opacity and blending to fin-
ish the effect. For this image, I chose to reduce the opacity to around 50%, 
and set the blending mode to Overlay to preserve the burning effect from the 
black areas.

While this result looks pretty good, we can make it even more stylized by 
changing up the gradient a bit. Back in the Gradient Editor, I’ll change the 
far-left Black color stop to a bright red (RGB: 255, 5, 50), then move the 100% 
Opacity stop to about the midway point. A few other color stop moves, and 
here’s the new result.
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Because I made changes to the previous preset, I can save a new one as well to 
the same collection. This also gives me an excuse to remind you of a great trick 
using Libraries. Starting in Photoshop 2020, you can see your new presets in 
the Gradients panel (Window > Gradients) and simply click one to load it into 
a Gradient Fill layer. The problem is that the radial style is not preserved, nor is 
the scaling. When you go to apply your saved preset, you’ll have to make those 
settings changes. To get around this, you can drag your entire Gradient Fill 
layer to a Creative Cloud Library. Whenever you want to use it again, just drag 
it out to your Layers panel while holding Opt/Alt, and—boom!—instant stylized 
vignette.

Of course, you are not limited to gradients. It’s entirely possible to create 
vignettes with painting techniques. Turn off or delete the previous vignette 
and fill layers, and add a fresh, blank layer. Select the Brush tool, grab a large 
soft brush, and lower the opacity to around 30%, and the flow to 10%. This 
will allow you to scrub and color in the effect a little more carefully.

Hold Opt/Alt to temporarily switch to the Color Sample tool, and click to 
select any color you’d like to try for the border. Release the modifier key and 
begin painting along the same edge you sampled from. Let the paint build up a 
little at a time, focusing on removing distracting details from the edges of your 
photo, or drawing focus towards the subject. This is a good technique to start 
with to ensure some harmony among the colors in your image, but you do 
have to choose carefully.

With the paint layer still active, try out some of the blending modes. Color is 
a good one for supporting a particular palette, building a theme across several 
images, or connecting the image to a viewing environment. Color Burn, as 
used in the Neutral Density Gradient, will provide a dramatic darkening effect. 
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Continue painting the other edges using the sampling method or using com-
pletely different colors as you go.

Remember: the point of adding vignettes is to enhance your photo by leading 
focus, and that means reducing visual clutter away from the subject.

REMOVING VIGNETTES
Now that we have spent some time adding vignettes, let’s think 
about how to remove them. Shooting wide open on most lenses can 
give you some vignetting under the best of conditions, as will using 
a polarizer. When I first encountered this and tried removing them 
in Photoshop, I relied heavily on manually painting them out. As 
you may expect, that was neither easy nor particularly effective.

Here’s a common situation with a simple vignette.

Let’s remove it! On a blank layer above your photo (with no other 
effects or adjustments active), create a radial gradient that mim-
ics the existing vignette to a reasonable extent. Start by choosing 
the Gradient tool (G) and the Foreground To Background preset. Hold Opt/
Alt while clicking on a representative dark area of the vignette, preferably in 
a fairly solid area. (You may find it helpful to instead use the Eyedropper tool 
(I) with a larger sample size to help average out the color.) Press X to swap the 
foreground and background, then Opt/Alt-click near the center of the image 
away from the subject to sample a representative color from that area. The 
gradient ramp in the options bar should have the lighter center color on the 
left, and the corner color on the right. Remember that you’re selecting colors 
that you want to neutralize.
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Using the Radial style, drag out from the center to the corners. For smooth 
vignettes, this should be pretty straightforward, but be aware that you may 
have to transform the gradient a bit in some cases.

Change the blending mode of the gradient layer to Divide. The background 
should be nearly completely white. Remember: anything divided by itself is 1, 
and in Photoshop that means white. Now we can mask the subject and lower 
the opacity of the gradient layer to blend everything.

Of course, this is a really simple example to demonstrate the idea. Things get a 
little more complicated when there is more texture and a bigger subject. Con-
sider this image across San Diego Bay in California; I took it at the same time 
and location as the gull picture above.
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In this case, the corners have clouds and some rich color, so 
we’ll have to be a little more careful. Instead of sampling the 
sky near the center of the image, let’s just leave it transpar-
ent. Select the Transparency box in the options bar, and click 
the gradient swatch to open the Gradient Editor. Ensure 
the darker corner color is on the right, with its Opacity stop 
set to 100%. The lighter color should be on the left, and its 
Opacity stop set to 0%.

Again, drag out the gradient on a blank layer so that the 
corners are darkened.

It turns out that a few blend modes can work, so the impor-
tant thing to remember is that you want to use the sampled 
color to lighten the area. Modes that lighten include Screen, 
Soft Light, and Linear Dodge (Add). In this case, because 
there is more texture and a slightly saturated color, Linear 
Dodge works really well, with about 60% opacity (and of 
course masking the buildings).
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Something to watch for with Divide is desaturation in the blended areas. Mod-
erating this result usually means adding back in some color on a new layer, 
or reducing opacity even further. Both can have some unintended results. For 
clear skies, it may be more useful to try a Luminosity blend, instead. This is 
effective when the actual hue is relatively constant across the area that you 
need to correct, but varies mostly in brightness. If your scene has any clouds or 
other elements, they’ll have to be masked out. But let’s skip ahead to a slightly 
more complex situation with Luminosity.

There’s a strong vignette in this image, but no real way to isolate a color or 
single luminosity value to put into a gradient. In this case, I tend to use a simple 
black-to-white radial gradient knowing that I’ll have to do some additional 
corrections. The gradient layer is of course set to Luminosity, but look how 
washed out everything is even at 20% opacity.
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The solution is to toss in some Blend If goodness using the Underlying Layer 
slider, then mix with a little Curves and Hue/Saturation. This operation effec-
tively equalizes the value variation from center to corner. You can think of it 
like another frequency, except at a very large scale compared to the image. 
To negate the frequency, you hit it with a little of the opposite frequency, the 
radial gradient. Because the larger frequency also affects the details, those will 
need to be brought back.

You may be wondering about the built-in vignette controls in Camera Raw. 
They’re great! If you haven’t discovered them before, now would be a great 
time to open an image in Camera Raw. Convert your layer to a Smart Object, 
then choose Filter > Camera Raw Filter. The vignette slider is under the Lens 
Corrections tab. There is a single slider that accomplishes some of what we’ve 
done above.

Even faster to use than Camera Raw is Lens Correction on the Filter menu. 
This is applied as a destructive filter, so either duplicate your photo layer or 
convert it to a Smart Object before using it. After choosing Lens Correction, 
you will need to open the Custom tab and look in the middle of the controls 
selection. The Vignette slider lets you choose to lighten or darken the corners, 
and the Midpoint slider adjusts the shape and transition of the correction (or 
effect if you choose to add a vignette).

While these built-in solutions are amazing, there are situations where they 
are just not enough. For example, the Vignette correction sliders won’t help 
much with darkening only in one corner, which can happen with polarizers or 
shadows. It also won’t help with smoothing out linear variations as may hap-
pen with a shadow in the foreground. Using the above techniques let you have 
direct, precise control over myriad situations that the Camera Raw and Lens 
Correction filters won’t handle.
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BRIGHT EYES
One of the secrets of retouching is enhancing small details 
that draw a viewer’s attention. For faces, that means eyes! Add-
ing a little brightness and shine to the subject’s eyes will make 
them seem more lifelike to the viewer. This technique should be 
used with restraint, as overdoing it will be obvious, or at least 
disturbing.

The choice to use Soft Light here is a nod to that restraint. When 
I first started using this technique, I relied on Screen, which does 
not become useful until the opacity is lowered (multiply is the 
same way). That meant at some point I was not actually bright-
ening the colors so much as adding white and desaturating. Soft 
Light is not nearly as strong as Screen, but has the advantage of 
preserving the saturation of the lighter colors.

On a blank layer above the photo, set the blending mode to Soft 
Light. Use a soft, round brush set to about 20% opacity and 30% 
flow, a little smaller than the iris (the colored part of the eye). 
Choose white as your foreground color and work gently around 
the lighter areas of the eyes, paying attention to and preserving 
much of the natural shading. The soft brush will also brighten a 
little of the skin around the eye, and that’s fine so long as it’s not 
overdone. The goal is subtle enhancement, not a glowing horror 
film effect.
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Once the overall shaping is complete, decrease the brush size to about half that 
of the iris, then lower the opacity to about 10%. Look for where the image light 
is coming from and how it highlights the iris. There should be a lighter and 
darker area, and you will paint very carefully in that lighter region, creating a 
new highlight (avoid the pupil at this stage). If the effect is too much, undo it 
and lower the Flow setting to 10%. You should look for just the barest change 
here at first.

For softly lit portraits, this should probably be all you need for the highlights. 
You want to both enhance the shape of the eyeball and bring out the color 
without diluting it. Highlights over the iris are meant to show clarity as well as 
draw attention.

Now it’s time to work in the darks just a bit. Switch the paint color to black and 
ensure the brush is small enough to deal with the edges of the iris. Gently 
brush over the dark edges to give them a little more presence. You can also use 
this over the pupils, but don’t fill them in completely—a tiny variation in the 
blacks implies depth here.

The rims of the eyelid can also be painted over, especially at the 
outer edges of the subject’s eyes. This same technique can be 
applied to eyelashes as well.

Bring a little of the color back in with a new blank layer set to 
Overlay blending mode. Sample a part of the eye color that is 
reasonably saturated but not too dark. Make a few small strokes 
outward from the pupil to the edge of the iris. This is a really 
subjective part of the technique, as it’s easy to get wrong. The 
look you’re going for is to disrupt the highlight just enough to 
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maintain realism, without creating artifacts or looking like the eyes have been 
colored in. Overlay will have the effect of darkening these areas most typi-
cally, unless the model has extremely bright irises already (such as you might 
encounter with colored contacts or some animals). Often, just a few dabs or 
tiny strokes will be sufficient.

Overlay is a bit stronger than Soft Light, and helps bring back some of the 
saturation of the colors you sample from the eye without losing detail or caus-
ing artifacts. Here is a little demonstration of using the various blending modes 
for this kind of dodge and burn.

Notice that Overlay (bottom pair of lines) has a stronger effect in the midtones 
when painting with black or white, while Soft Light is more uniform across the 
range from black to white. When you want to enhance what’s there, choose 
one of these two blending modes.
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In some cases, you can get a dramatic, vibrant change using a slightly different 
approach. Rather than gently painting in the highlights, this is kind of a brute 
force method of getting a glassy-eyed look.

On a blank layer set to Normal blending, use a hard, round brush the same size 
as the iris. Set the brush’s Flow and Opacity options to 100%. Pick a neutral 
gray, around 55% brightness, and stamp a single dot over each eye. Add some 
noise for texture by choosing Filter > Noise > Add Noise, and choose Gaussian, 
about 15%–25%. Deselect Monochrome so you get some color variation.

Now change the layer blending mode to Divide.

Egad! It’s horrible! Lower the Opacity—quick. Depending on the 
original eye, the opacity range could be anywhere from 10% up to 
80%, so just try it out. Now add a layer mask and soften your round 
brush. Mask the edges and the pupil. Alternatively, switch the Brush 
blending mode in the options bar to Clear. This erases the paint on 
the canvas using the same brush, and you can avoid creating a mask. 
Also, if the speckled colors are too strong, use a Gaussian blur of 
about 1 pixel to soften the look.

Now we have a very bright, highlighted iris. Both methods can be made to give 
nice results. The painting method gives you control over position and shape 
of the highlights, while the selection method is very fast. There is no reason 
the two can’t be combined, either. In general, Soft Light blending will be more 
precise and fit a wider variety of eye colors with little variation. The Divide 
method can be hit or miss, but gives really dramatic results very quickly.
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Invert, 276
Levels, 263–266
Pattern, 283
Photo Filter, 273
Posterize, 276
Selective Color, 278–279
Solid Fill, 282
Threshold, 278
Vibrance, 268
See also specific adjustment layers

Adjustments library, 184
Adjustments menu, 260
Adjustments panel, 37
Adobe Sensei AI, 54, 239
alpha blending, 288
alpha channels, 54–55

creating, 63–64, 70
selections using, 55, 71

Apply Image dialog box, 190, 250
art, concepts expressed through, 13
Artistic Brushes Canvas set, 205
assets, naming, 216
atmospheric effects, 193–200
author’s personal note, 4–6
Auto button

Black & White adjustment layer, 272
Brightness/Contrast adjustment layer, 263
Levels adjustment layer, 265

Auto Color Correction Options dialog box, 153, 
155, 265

automated selections, 54
Average Blur filter, 147, 148, 150

\ (backslash key), 72
3DL format, 135
8-bit mode, 251
16-bit mode, 251
50% gray, 24, 87, 290

A
Absolute color adjustments, 279
abstracting the tools, 6–7
Ackoff, Russell, 12
Adams, Ansel, 163
Add Noise filter, 122, 194, 195, 230
adjustable lighting, 11–12
adjustment layers, 15, 259–262

adding to documents, 37
adjustments vs., 70, 260
blending modes used with, 39, 95–96
color channels targeted by, 39
grouping, 140
masks used on, 37–38
options for choosing, 260
Properties panel buttons, 261

adjustment layers reference, 259–283
Black & White, 271–272
Brightness/Contrast, 262–263
Channel Mixer, 273–275
Color Balance, 270–271
Color Lookup, 275
Curves, 266–267
Exposure, 267–268
Gradient Fill, 282–283
Gradient Map, 280–281
Hue/Saturation, 269–270

INDEX
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Color Dodge, 310–311
Darken, 298–299
Darker Color, 306–307
Difference, 328–329
Dissolve, 296–297
Divide, 332–333
Exclusion, 330
Hard Light, 318–319
Hard Mix, 326–327
Hue, 333–334
Lighten, 308
Lighter Color, 314–315
Linear Dodge, 312–313
Linear Light, 322–323
Luminosity, 337
Multiply, 299–300
Normal, 296
Overlay, 315–316
Pin Light, 324–325
reference images, 292–295
Saturation, 334–335
Screen, 309
Soft Light, 317–318
Subtract, 331
Vivid Light, 320–321
See also specific blending modes

blending process, 39
blocking process, 168
blur filters

Average Blur, 147, 148, 150
Median Blur, 255
Motion Blur, 194, 195
Path Blur, 229, 230
See also Gaussian blur

Blur tool, 76
Boolean selections, 57, 65, 137
brightening eyes, 119–122
brightness, 13

lightness vs., 143
luminosity vs., 14

Brightness slider, 262
Brightness/Contrast adjustment layer, 262–263
bristle brushes, 205, 206

B
B&W Control Freak method, 167–171
backdrop, 39, 286
background fixes, 236
backslash key (\), 72
base layer, 39, 136, 286, 292
Berlier, Rocky, 163
bit depth, 251
Black & White adjustment layer, 271–272

color to grayscale conversion and, 31–33, 167, 168
Gradient Map used with, 130–131
Luminosity blending mode and, 33, 221, 272
stamped portrait effect and, 202
Targeted Adjustment Tool and, 261, 272

black-and-white images
Color blending mode applied to, 127
converting color images to, 31–33, 167–171

black-to-white gradient, 29, 161, 163, 167
blemish reduction, 253
Blend If feature, 40–47

color adjustments, 41–45
comparisons made with, 46
crossing the sliders, 98
duotone effect and, 127
how it works, 40–41
image enhancements, 94, 96–97
trapping transparency using, 46–47
vignette removal, 117

blend layer, 39, 286, 293
blending modes, 16, 285–295

adjustment layers and, 39, 95–96
Blend If sliders and, 40–47
categories of, 286–287
controls and options for, 40
Fill and Opacity adjustments, 39, 287–289
group options for, 74, 78–80
image enhancement using, 93–97
math used for, 290–292
multiple layers required for, 15
painting with, 80–83

blending modes reference, 285–337
Color, 336
Color Burn, 302–303
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definition of, 13
helper layer for seeing, 179–180
matching, 151–159
perceptual models of, 17
replacing, 136–146
selecting, 57–58

Color Balance adjustment layer, 270–271
black-and-white conversions and, 170
color matching and, 159
color replacement and, 140, 144

color bars project, 215–222
Color blending mode, 336

color cast removal and, 147
color grading and, 126, 127
color matching and, 155
color replacement and, 136–137
dissolve portrait effect and, 209
helper layers and, 176
vignette creation and, 112

Color Burn blending mode, 302–303
color cast removal and, 149
example of math used for, 291
GND filter creation and, 105
reference images, 303
vignette creation and, 112

color cast removal, 146–151, 271
color channels. See channels
Color Dodge blending mode, 310–311

portrait retouching and, 149
reference images, 311

color grading, 126–135
accuracy requirements for, 134
color lookup tables for, 131–135
Gradient Maps for, 129–131
Hue/Saturation adjustments for, 128
Solid Color fill layer for, 126–127

Color Lookup adjustment layer, 275
Candlelight preset, 102
color grading with, 131, 132
mask created for, 65

color lookup tables (CLUTs), 131–135, 160
color matching, 151–159
Color Picker, 155, 180, 245, 265

Brush Settings panel, 204
brush tip presets, 204
Brush tool

choosing style for, 204
resetting to Normal blending mode, 81
vignettes painted with, 112

Brushes panel, 204
burning and dodging. See dodging and burning

C
Calculations dialog box, 59–60
Camera Raw filter, 117
Camera Raw vignette controls, 117
canvas

copying everything on, 48, 69
previewing results on, 60

Channel Mixer adjustment layer, 39, 273–275
channel selections, 54–61

alpha channels and, 54–55
Boolean operations for, 57–58
calculations used for, 58–61
description of making, 55–58

channels, 14
adjustment layers and, 39
alpha, 54–55, 63–64
Curves adjustments, 98–99
duplicating, 70
experiment file, 225–226
multipliers used for, 17
RGB composite, 59, 222
selections using, 54–61

Channels panel, 57, 208, 225
CIE model, 17
Claw technique, 48, 69, 195
clipping display, 264
clipping layers, 38
Clone Stamp tool, 175, 237, 254
Clouds filter, 192
CMYK color space, 17
color

Blend If adjustments, 41–45
converting to grayscale, 31–33, 167–171
Curves adjustments, 29–31



342 index

Pin Light blending mode, 324–325
Soft Light blending mode, 317–318
Vivid Light blending mode, 320–321

Contrast slider, 262
Creative Cloud Library, 112
Creative Console, 10
Crystallize filter, 194, 195
CUBE format, 135
Curves adjustment, 70, 260, 261, 266
Curves adjustment layer, 15–16, 19–28, 266–267

blending modes and, 94–97
channel curves tweaked with, 98–99
color adjustment and, 29–31
color cast removal and, 148
color matching and, 153, 155
color replacement and, 140, 144
Curves adjustment vs., 70
dodging and burning with, 89–91
dragging to library, 155, 156
experiment files, 219–220, 226
gradient adjustments, 23–28, 45
Hard Mix blending mode and, 98, 101
inversion adjustments, 176
Levels adjustment layer vs., 261
Overlay blending mode and, 24, 94, 96
remapping process, 20–22
Screen blending mode and, 95, 96
Solarize curve creation, 178–179
Targeted Adjustment Tool and, 30, 261

Curves panel, 21
Curves Properties panel, 30, 61, 220, 267

D
Darken blending mode, 237, 254, 298–299
Darken blending mode collection, 298–306

Color Burn blending mode, 302–303
Darken blending mode, 298–299
Darker Color blending mode, 306–307
Linear Burn blending mode, 304–305
Multiply blending mode, 299–300

Darker Color blending mode, 306–307

color ramp, 68, 69, 109, 129, 269–270
Color Range option, 73
color replacement, 136–146

general techniques for, 136–140
specific targets of, 141–146

Color Sampler tool, 142
color samples

saving to library, 155–156
tool for selecting, 142

Color Theory, 13
Colorize option, 270
commutative blending modes, 286

Darken, 298–299
Darker Color, 306–307
Difference, 328–329
Exclusion, 330
Hard Mix, 326–327
Lighten, 308
Lighter Color, 314–315
Linear Burn, 304–305
Linear Dodge, 312–313
Multiply, 299–300
Screen, 309
See also non-commutative blending modes

Component blending mode collection, 333–337
Color blending mode, 336
Hue blending mode, 333–334
Luminosity blending mode, 337
Saturation blending mode, 334–335

composite portrait, 243–244
Constant slider, 274
Content Aware Fill, 236
contrast

Hard Mix, 97–102
increasing, 93, 94
rain effect, 196
reducing, 24

Contrast blending mode collection, 315–327
Hard Light blending mode, 318–319
Hard Mix blending mode, 326–327
Linear Light blending mode, 322–323
Overlay blending mode, 315–316
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ergonomic solutions, 11, 163
Exclusion blending mode, 330
experiment files, 6, 33, 214–232

basic color bars, 215–222
best practices for, 216
gradient experiments file, 214–215
hue wheel, 227–228
RGB triangle, 224–227
solving problems with, 228–231, 232

Exposure adjustment layer, 170, 267–268
Exposure slider, 267
eye brightening, 119–122
Eyedropper tool, 113, 155
eyedroppers, 154, 264
eyestrain, 11

F
Fade command, 192
Feather slider, 73, 101
Fill adjustments

blending modes and, 39, 287–289
Gradient Fill, 109, 110, 236, 282–283
Solid Color fill, 126–127, 146, 244, 282

Fill dialog box, 87, 90
Fill slider, 219, 288, 296
filling

layers, 87
selections, 74–75

filters
Add Noise, 122, 194, 195, 230
Average Blur, 147, 148, 150
Camera Raw, 117
Clouds, 192
Crystallize, 194, 195
Find Edges, 54
Graduated Neutral Density, 104–106
High Pass, 250, 316
Lens Correction, 117
Median Blur, 255
Motion Blur, 194, 195
Path Blur, 229, 230

Find Dark & Light Colors option, 265
Find Edges filter, 54

data
pixels as basic, 12
seeing images as, 18

Density slider, 73, 101, 273
desaturating

layers, 69
target areas, 138, 139

Difference blending mode, 67, 68, 328–329
digital image processing, 14–18
DIKW initialism, 12
Dissolve blending mode, 296–297

calculations for, 286
portrait effect, 206–209

distortion effects, 229
Divide blending mode, 332–333

eye retouching and, 122
vignette removal and, 114, 116

dodging and burning, 85–92
best practices for, 91–92
Curves adjustment layers for, 89–91
dedicated tools for, 86
duplicate layers for, 86–87
Overlay blending mode for, 87–89
portrait retouching and, 235

drop shadows, 300
duotone effect, 127
duplicating channels, 70

E
editing

gradients, 62, 160–163
masks, 70, 73, 75–78, 79

effects, 187–209
dissolve portrait effect, 206–209
Orton effect, 188–193
rain and atmosphere, 193–200
stamped portrait, 201–206

Eliot, T. S., 12
Elliptical Marquee tool, 227
Enhance Brightness & Contrast option, 265
Enhance Monochromatic Contrast option, 265
Enhance Per Channel Contrast option, 265
equilateral triangle, 224–227



344 index

gradients
Blend If settings, 43–44
color creation, 29
creating and editing, 62
Curves adjustments, 23–28
experiments file, 214–215
GND filter creation, 104
noise, 281
Posterize adjustments, 20, 23, 28
presets for, 62, 109, 110, 130, 280, 283
vignette creation, 107
zone control, 160–166

Gradients panel, 112, 130, 215
Graduated Neutral Density (GND) filters, 104–106
graphic controls, 19
graphics tablets, 9–10
gray step wedges, 128
grayscale

converting color to, 31–33, 167–171
viewing saturation as, 184

groups
adjustment layer, 140
blending mode of, 74
helper layer, 184

guides
changing color of, 216
dragging into documents, 224

H
Hard Light blending mode, 318–319
Hard Mix blending mode, 326–327

contrast enhancement, 97
Curves adjustment layer and, 98, 101, 226
Levels adjustment layer and, 177
reference images, 327

Healing Brush tool, 237
helper layers, 173–184

color/hue, 179–180
explanation of, 174
grouping, 184
Invert, 175
luminosity, 176–177

Flat Fan brush, 204, 205
Flat Round Mixer Brush, 206
Foreground to Background gradient, 215
frequency

descriptions of, 248
high vs. low, 248–249

Frequency Separation, 247–255
bit depth related to, 251
high vs. low frequency and, 248–249
portrait retouching and, 237
variations on technique of, 254–255

G
Gamma Correction slider, 267
gamma readout, 263
Gaussian blur

color cast removal and, 150
eye retouching and, 122
mask selections and, 70, 75, 79
Orton effect and, 188–189, 192
rain effect and, 194
skin retouching and, 250, 252
See also blur filters

GND filters, 104–106
Gradient Editor, 160–163

editing with, 62
gradient bar, 160–161
preset creation, 217
Smoothness slider, 20
vignette creation, 109, 110

Gradient Fill adjustment layer, 282–283
portrait retouching and, 236
vignette creation and, 109, 110

Gradient Map adjustment layer, 280–281
adding and working with, 62
color grading with, 129–131
luminosity selections with, 61–65
range selections with, 100–101
zone control with, 163

Gradient Picker, 62
gradient ramp, 109, 113, 131, 163, 280
Gradient tool, 104, 107, 215, 217, 218
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L
language note, 13–14
Lasso tool, 70, 76, 252
layer masks. See masks
layer stacks, 15
Layer Style dialog box, 40, 94, 149
layers, 14–15

applying adjustments to, 37
blending controls, 39–48
clipping, 38
desaturating, 69
filling, 87
helper, 173–184
naming, 174
Smart Object, 47, 195
See also adjustment layers

Legacy Gradients, 109, 130
Legacy mode, Brightness/Contrast, 263
Lens Correction filter, 117
Levels adjustment, 260, 261, 263
Levels adjustment layer, 263–266

color matching and, 157
Curves adjustment layer vs., 261
Hue/Saturation selections and, 68–69
inversion adjustments, 177
mask editing using, 75–78, 79
Orton effect and, 192
rain effect and, 199

Libraries panel, 140, 155, 184
Lighten blending mode, 308

rain effect and, 198
skin retouching and, 253

Lighten blending mode collection, 308–315
Color Dodge blending mode, 310–311
Lighten blending mode, 308
Lighter Color blending mode, 314–315
Linear Dodge blending mode, 312–313
Screen blending mode, 309

Lighter Color blending mode, 29, 314–315
lighting, adjustable, 11–12
Lightness slider, 128, 137, 143, 269
lightness vs. brightness, 143

naming suggestions, 174
Saturation Mask, 183–184
Solarize, 178–179
Threshold, 181–182

high frequency, 248, 249
High Pass filter, 250, 316
HSB color option, 142
HSL color space, 269
Hue blending mode, 333–334

color grading and, 127
color replacement and, 136

Hue slider, 45, 139, 146, 269
hue wheel/circle, 227–228
Hue/Saturation adjustment layer, 269–270

Blend If settings and, 45
color cast removal with, 148
color grading with, 128
color replacement with, 137, 139–140, 143–144
desaturating target areas with, 139
Orton effect and, 192
reducing saturation with, 102
selections using, 67–71
Targeted Adjustment Tool and, 68, 261, 270

hues
definition of, 13
isolating, 180
ramps for, 269–270

I
ICC Abstract format, 135
image enhancement, 93–97
Info panel, 142, 144
information vs. data, 12
Inversion blending mode collection, 328–333

Difference blending mode, 328–329
Divide blending mode, 332–333
Exclusion blending mode, 330
Subtract blending mode, 331

Invert adjustment layer, 175, 276

K
keyboard, 11
knowledge, 13
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saturation, 183–184
toggling on/off, 72
viewing, 72

Masks Properties panel, 101
matching colors, 151–159
meaning, information and, 13
Median Blur filter, 255
midpoint slider, 117, 199, 263–264, 280
midtone contrast, 24
Mixer Brush tool, 204, 205–206, 252, 254
Monochrome option, 274–275
Monogram Creative Console, 10
Motion Blur filter, 194, 195
Move tool, 217
Multiply blending mode, 299–300

darkening photos with, 93
GND filter creation and, 105, 106
group masking and, 74, 78–80
mask editing and, 70, 73
math used for, 291
Threshold adjustment layer and, 181

N
naming

assets, 216
layers, 174

neutral color blending modes, 287
neutral values, starting with, 169
New Channel icon, 70
New Layer dialog box, 260
noise, adding, 122, 194
noise gradients, 281
non-commutative blending modes, 286–287

Color, 336
Color Burn, 302–303
Color Dodge, 310–311
Divide, 332–333
Hard Light, 318–319
Hue, 333–334
Linear Light, 322–323
Luminosity, 337
Overlay, 315–316
Pin Light, 324–325

Linear Burn blending mode, 304–305
Orton effect and, 190–191, 192
reference images, 305

Linear Dodge blending mode, 312–313
portrait retouching and, 236
rain effect and, 197
reference images, 313
vignette removal and, 115

linear gradients, 104, 201, 226
Linear Light blending mode, 322–323
low frequency, 248, 249
luminance, 14
luminosity

brightness distinguished from, 14
color channel multipliers and, 17
removing from images, 179
selections based on, 61–65

Luminosity blending mode, 337
Black & White adjustment layer and, 33, 221, 272
color matching process and, 157
experiment file for, 228
Gradient Map adjustment layer and, 163
luminosity removal and, 179
portrait retouching and, 237, 241, 253
Spot Healing Brush and, 253
vignette removal and, 116

luminosity masks, 61

M
Magic Wand tool, 71, 150, 181, 208
manual selections, 54
“marching ants” line, 56
Marquee tool, 218
masks

adjustment layer, 37–38
alpha channels and, 54–55
color replacement using, 138–139
group blending mode for, 78–80
Levels adjustment, 75–78, 79
luminosity, 61
painting, 80–83
promoting, 73–75
proportional, 139
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Pattern adjustment layer, 283
perceptual color models, 17
Photo Filter adjustment layer, 273
Photoshop image processing, 14–18
Pin Light blending mode, 324–325
pixels, data as, 12
Polygonal Lasso tool, 225
portrait effects, 201–209

dissolve portrait, 206–209
stamped portrait, 201–206

portrait retouching, 234–238
basic process for, 234–238
Rembrandt portrait example, 239–247
skin retouching and, 249–254

Posterize adjustment layer, 276
experiment file, 222
gradients and, 20, 23, 28
how it works, 31

Preserve Luminosity checkbox, 271
presets

Black & White, 272
brush tip, 204
Channel Mixer, 273, 275
CLUT, 131, 132, 135
Color Lookup, 275
gradient, 62, 109, 110, 130
Gradient Map, 280, 283
Hue/Saturation, 270
Levels, 264
Photo Filter, 273

previews
calculation results, 59, 60
clipping results, 264
Smart Object effect, 199
tonal variation, 273

problem solving, 228–231, 232
project examples, 213–255

color bars, 215–222
experiment files, 214–232
frequency separation, 247–255
gradient experiments file, 214–215
hue wheel, 227–228

Saturation, 334–335
Soft Light, 317–318
Subtract, 331
Vivid Light, 320–321
See also commutative blending modes

Normal blending mode, 296
eye retouching and, 122
group mode as, 74
resetting Brush to, 81

O
Offset slider, 267
Opacity adjustments

blending modes and, 39, 287–289
dissolve portrait effect and, 208
experiment file for, 222
vignette creation and, 110

Opacity slider, 273, 288, 296
Orton effect, 188–193
Orton, Michael, 188
Overlay blending mode, 315–316

contrast increased with, 93, 94
Curves adjustment layer and, 24, 94, 96
dodging and burning with, 87–89
eye retouching and, 120–121
gradient layers and, 44
painting with, 81, 120–121
portrait retouching and, 241, 246
rain effects and, 195–196
stamped portrait effect and, 203
Theshold adjustment layer and, 182
vignette creation and, 111

P
painting

color replacement by, 136–137
eye retouching by, 119–122
masks with blending modes, 80–83
vignettes created by, 112

parametric controls, 19, 20
Pass Through blending mode, 74
Path Blur filter, 229, 230
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S
saturation

desaturating, 69, 138, 139
helper layer for seeing, 183–184

Saturation blending mode, 180, 334–335
Saturation mask, 183–184
Saturation slider, 68, 269
Screen blending mode, 309

Curves adjustment and, 95, 96
lightening photos with, 93, 95
Orton effect and, 191, 192
rain effect and, 199
Threshold adjustment layer and, 182

Select Subject command, 54, 72, 78–79, 236, 239
selections, 54–71

automatic, 54
Boolean, 57, 65
channel, 54–61
filling, 74–75
Gradient Map luminosity, 61–65
Hue/Saturation, 67–71
loading, 73, 74
manual, 54
subject, 78–79, 203

Selective Color adjustment layer, 278–279
black-and-white conversion and, 169–170
color matching and, 158–159
saturation view using, 183–184

selective sharpening, 229
self blends, 39, 220, 226, 310
semi-automated selections, 54
Sensei AI, 54, 239
Sepia Gradient Map, 170
shade, definition of, 13
Sharpen tool, 206
sharpening

High Pass, 250, 316
selective, 229

skin retouching, 249–254

portrait retouching, 234–238
Rembrandt portrait, 239–247
RGB triangle, 224–227
solving problems, 228–231, 232

promoting masks, 73–75
Properties panel, 68, 73, 221, 260, 261
proportional masks, 139
Protect Tones option, 86

Q
quantization, 31
Quick Select tool, 239

R
radial gradients, 107, 114
rain effects, 193–200
ramps

color, 68, 69, 109, 129, 269–270
gradient, 109, 113, 131, 163, 280

Randomize button, 281
range sliders, 270
Raw Linen texture, 205
Rectangular Marquee tool, 217, 224
reference chips, 128
references. See adjustment layers reference;  

blending modes reference
Relative color adjustments, 279
remapping process, 20–22
Rembrandt portrait project, 239–247
Rembrandt van Rijn, 239
removing

color cast, 146–151
luminosity, 179
vignettes, 113–117

retouching portraits. See portrait retouching
Retouching Toolkit (RTK), 10–11
Reverse option, 109
RGB color space, 17
RGB triangle project, 224–227
Rock, The (Eliot), 12
Roughness slider, 281
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Linear Burn, 304–305
Linear Dodge, 312–313
Linear Light, 322–323
Vivid Light, 320–321

Spot Healing Brush tool, 237, 253
Stamp Merge Visible technique, 48
stamped copies, 48, 69, 151, 195
stamped portrait effect, 201–206

Mixer Brush tool and, 204, 205–206
Smudge tool and, 204–205
technique for setting up, 201–204

Subtract blending mode, 331

T
Target Colors & Clipping option, 265
Targeted Adjustment Tool (TAT)

Black & White adjustment layer and, 261, 272
Curves adjustment layer and, 30, 261
Hue/Saturation adjustment layer and, 68, 261, 270

textures
preserving, 70
rain effect, 196–197
stamped portrait effect, 205

This Layer slider, 42
Threshold adjustment layer, 278

as helper layer, 181–182
stamped portrait effect and, 201–202

Threshold Level slider, 202
tint, definition of, 13
Tint image option, 272
tone, definition of, 13
tools, abstracting, 6–7
Transform Selection option, 224
transparency, trapping, 46–47
triangle creation, 224–227

U
Underlying Layer slider, 43, 45, 117

V
value, brightness as, 13
Vibrance adjustment layer, 268

Smart Filters
Black & White, 271
Brightness/Contrast, 262
Channel Mixer, 273
Color Balance, 270
Color Lookup, 275
Curves, 266
Exposure, 267
Gradient Fill, 282
Gradient Map, 280
Hue/Saturation, 269
Invert, 276
Levels, 263
Pattern, 283
Photo Filter, 273
Posterize, 276
Selective Color, 278
Solid Fill, 282
Threshold, 278
Vibrance, 268

Smart Objects, 47, 195, 199
Smoothness slider, 20, 280
Smudge tool, 204–205
Snap Neutral Midtones option, 265
snapping feature, 217
Soft Light blending mode, 317–318

brightening eyes with, 119, 121, 122
contrast increased with, 93
Orton effect and, 192
portrait retouching and, 241

Solarize curve, 178–179
Solid Color fill layer, 282

color grading and, 126–127
color replacement and, 146
portrait retouching and, 244

Solid Fill adjustment layer, 282
solving problems, 228–231, 232
Special 8 blending modes, 287

Color Burn, 302–303
Color Dodge, 310–311
Difference, 328–329
Hard Mix, 326–327



350 index

W
Wacom tablets, 9–10, 204
wisdom, molding knowledge into, 13
workbench files. See experiment files

Z
zone control, 160–166

viewing
masks, 72
saturation, 183–184

vignette slider, 117
vignettes, 106–117

adding, 106–113
removing, 113–117

Vivid Light blending mode, 320–321
portrait retouching and, 244
reference images, 321
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